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Preface Structure of this Manual This manual consists of 4 chapters and 4 appendices. “Introduction” introduces the functions and architecture of the M4000 Insulation Analyzer, as well as important safety considerations for its use.



Chapter 2



“M4000 Software” provides an overview of M4000 software and its installation.



Chapter 3



“Running M4000 Tests” describes procedures for executing specimen tests.



Chapter 4



“M4100 Instrument Troubleshooting” provides initial steps in troubleshooting problems and isolating a problem to either the M4100 or M4200c.



Appendix A



“M4000 Components Lists” describes accessories included with the M4000 Insulation Analyzer.



Appendix B



“Warranty” provides Doble warranty provisions applicable to the M4000.



Appendix C



“Error Messages” lists error message numbers and descriptions.



Appendix D



“Part Numbers” lists the M4000 Insulation Analyzer part numbers.
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Chapter 1



i



Conventions Used in this Manual The following terms and typographical conventions are used in the manual: Convention



Description



Windows



Refers to the Microsoft Windows operating system, Version 98 or later.



Click



Quickly press and release the left mouse button.



Double-click



Quickly press and release the left mouse button twice without moving the mouse.



Select



Position the cursor on the desired option and click the left mouse button once. Or, highlight the desired option using the arrow keys and press ENTER. Or, press ALT and the underlined letter.



Press



Type a single keyboard key. For example, press ENTER.



FN+(appropriate key) Press and hold the FN key, and press (appropriate key). July 22, 2005



Bold Courier Text



ii



Indicates characters to be typed.
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1. Introduction The M4000 Insulation Analyzer is used to determine the insulation quality of high-voltage power apparatus in the field. This portable test set incorporates automated Doble Testing with high accuracy and sensitivity, over a wide range of values, and with minimal susceptibility to electrostatic interference and noise.



The M4000 generates a 0-12 kV test signal with an internal sine wave generator, a 3 kVA power amplifier and a step-up isolation transformer. The M4000 then measures the voltage and current of the specimen and a reference impedance by periodically sampling instantaneous values with an A/D converter. The M4000 then calculates and reports test results by converting the sampled data into vector (magnitude and phase) quantities and applying conventional ac circuit theory. All reported results – including power loss, power factor and capacitance – are derived from the vector voltage and current. The M4000 rejects interference through the judicious application of shielding, line-synchronized reversal, and line frequency modulation (FM). The first two techniques are similar to those employed in the earlier Doble M2H product line. The FM technique involves running tests at sinusoidal frequencies 5% (or even 10%, if necessary) above and below the line frequency and averaging the results. The choice is user configurable. The inevitable interference current component is removed from the sampled data set before test results are calculated using synchronous detection. This is a mathematical process that separates out a single frequency component in a given signal. It is analogous to a bandpass filter centered at the test frequency. Synchronous detection is also useful for removing harmonic distortion and random noise in the test signal itself.



Safety The M4000 is designed to drive grounded and ungrounded specimens at lethal voltages and high power levels. Conventional ground-fault and currentlimiting schemes cannot be used to protect the operator under these test conditions. Therefore, the M4000 implements special safety techniques to minimize risk to the equipment operator.
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Measurement Principles



M4100 Instrument



Both an operator and safety supervisor must be present when specimens are tested. Each person holds a safety switch that directly controls the output of the power amplifier through redundant electromechanical relays. In addition, the control processor can vote to disable the dc supply to the safety relay coils, thereby disabling the amplifier output if certain conditions are not met. NOTE



For greater safety details, see ”Safety Practices – General Rules” on page 1-20.



M4000 Components The M4000 Insulation Analyzer consists of the following components: • • •



M4100 Instrument M4200c Controller or Third-Party Controller M4000 Software



The following auxiliary components are optional: July 22, 2005



• • • • • • • • • •



M4150 or M4151 Field Calibration Reference M4300 Transport Leakage Reactance Test Software External Reference Test Software DTA Software M4110 Leakage Reactance Interface M4120 External Reference Module Doble Standard Turns Ratio Capacitor Safety Strobe Temperature and Humidity Probe



M4100 Instrument The M4100 instrument supplies test voltage and test current to insulation specimens. The M4100 instrument also contains measuring circuits to determine the condition of the insulation under test, as well as direct control safety circuits to ensure electrical safety of personnel and test apparatus. The M4100 instrument has a time base generator that may be synchronized either with the power system supplying power to the test instrument, or with an internal crystal oscillator. This choice allows the test operator to select one of two modes of test operation, Line Sync Reversal or Line Frequency Modulation. When Line Sync Reversal Mode is selected, the time base is synchronized to the power source and the test will use the standard Doble 1-2
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polarity reversal technique to reverse the effects of electrostatic interference. Selecting the Line Frequency Modulation Mode of operation will synchronize the time base generator to the crystal oscillator. Two tests will be run for each programmed test sequence. The first test is run at a frequency of 57 Hz and the second test is run at 63 Hz. The measured test results of each test are combined and averaged to give a 60 Hz equivalent test result. When operating in the 50 Hz frequency, the same technique will apply. The first test will run at 47 Hz, and the second test will run at 53 Hz. This mode of test eliminates electrostatic interference from measurement, by avoiding measurement at power line frequency. It is also possible to select ± 10% of power line frequency as well.



•



•



The ground safety circuit verifies that the #6 bare copper safety ground, which is attached from the instrument to the apparatus earth ground, is at the same potential as the power supply ground. Two safety switches must be attached to the M4100 instrument front panel and in the closed or depressed position prior to testing. One switch is held by the M4000 Insulation Analyzer operator and the second switch is held by a safety supervisor. The M4100 can be configured to require both switches to be opened between test sequences for the M4000 Insulation Analyzer to operate. Release of one or both switches will terminate the test sequence and high voltage potential.



A safety strobe light can be used in conjunction with the instrument and is plugged into the front panel of the M4100. Whenever high voltage potential is applied from the M4100, the safety strobe light will be energized and flashing. Safety strobe connection will be required in order to operate the M4000 Insulation Analyzer, unless the default system configuration has been modified to allow for the absence of a safety strobe. In this case, the strobe connector can be removed from the M4100 front panel.
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Safety circuits have been designed into the M4100 instrument to ensure safety of personnel. High voltage will not be supplied by the instrument if either of the following circuits and conditions are not satisfied:



M4100 Instrument
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Figure 1.1 Safety Strobe Two optional items found on the M4100 front panel are the M4151 Field Calibration Reference, which will be discussed below, and a Temperature and Relative Humidity sensor. The Temperature and Relative Humidity Sensor will process temperature and humidity readings at the time of test.



Front Panel



Figure 1.2 M4100 Instrument
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Figure 1.3 M4200c Controller •



•



•



•
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The M4200c Controller is the interface between the operator and the M4000 Insulation Analyzer. The color display, control, data storage, printing and communication functions are all provided by the M4200c Controller. This component is covered in detail in a separate manual. The M4200c has been specifically designed and built to operate in outdoor substations and other environments hostile to electronic test equipment. The unit has been hardened to electrostatic discharge (ESD) and radio frequency interference (RFI) to reduce or eliminate their effects on internal electronic circuits. The outer case of the M4200c is made of ABS plastic over an aluminum chassis that makes it rugged and suitable for transporting to remote sites. The display is a six-inch by eight-inch color transflective liquid crystal display (LCD) that runs in the VGA mode. The display has high contrast in bright sunlight, and has backlight control for low ambient light conditions. An LCD heater is installed to allow for use in cold weather. An external monitor may be used in place of the LCD screen. Access to the external display connector is found behind the access door on the left side of the M4200c Controller.
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M4200c Controller



M4200c Controller



•



The keyboard is a standard notebook-type keyboard with a flexible skin around the keys to prevent dirt and moisture from contaminating the internal electronics and causing failure of the keyboard. An external keyboard may be used in place of this keyboard. Access to the external keyboard connector is to the right of the video connector behind the access door on the left hand side of the M4200c Controller. Ext. Mouse



Ext. Monitor



Modem



Ext. Keyboard
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LAN



USB Figure 1.4 M4200c Controller External Connections •



•



•



•



1-6



The M4200c has a pointer device installed below the keyboard on the front panel to allow for the use of mouse control of the display cursor. A port on the left-hand side of the M4200c allows for the use of an external, serial mouse. The M4200c has a built-in 200 dot per inch (dpi) graphic printer/ plotter. Paper for the printer/plotter is an uncoated thermal FAX paper provided by Doble. The M4200c is equipped with an internal FAX/Modem board that may be used to transfer data when used with the optional Doble Test Assistant (DTA) program. The M4200c has a built in ethernet connection.
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• •



The M4200c has a built in USB port. Data may be stored on an internal hard drive or on a 3 1/2 - inch floppy disk via the floppy disk drive located in the front of the controller.



Third-Party Controller Certain PC’s using a Windows-based operating system available from other suppliers can be used as a system controller in lieu of the M4200c controller. These alternative machines can be used to control M4000 operations.



M4000 Software Software provided with the M4200c or available to be loaded onto a ThirdParty Controller includes a program to run the M4000 Insulation Analyzer, and if desired, the optional Leakage Reactance Test, External Reference Test, and Doble Test Assistant (DTA) programs. For more information, refer to Chapter 2.



The purpose of the M4150 and M4151 Field Calibration References are to provide a means of obtaining System Status, Calibration Verification, and Field Recalibration Tests of the M4100 instrument in the field. (For an explanation of these tests, refer to ”Running Diagnostics” on page 4-21). The Field Calibration Reference is mounted in the front panel of the M4100 instrument.



Figure 1.5 M4151 Field Calibration Reference
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Optional M4150 And M4151 Field Calibration References



Doble Standard Turns Ratio Capacitor



Doble Standard Turns Ratio Capacitor This is an optional small portable capacitor that can be energized at 10 kV for performing turns ratio tests at high voltages with the M4000.



Figure 1.6 Doble Turns Ratio Capacitor
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External Reference This is an optional feature allowing the tester to test apparatus at their full operating voltage using the M4000, providing a suitable external power source and reference are provided by the user.



M4300 Transport The M4300 Transport is an option for the M4000 Insulation Analyzer that provides a means to move and store the M4000 system. It is also a platform for the field, from which the M4000 can be easily used and operated. Refer to ”Storage and Moving Mode” on page 1-10 and ”Testing Mode” on page 1-13. If a PC is to be substituted for the Controller, a support panel to be mounted on the Controller support frame can be supplied.
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Figure 1.7 M4300 Transport



Doble Test Assistant (DTA) Software Optional Doble Test Assistant® (DTA) software provides standardized apparatus test procedures and templates, data management, and optional expert system software for insulation condition assessment. See Chapters 2 and 3 for further details.



M4110 Leakage Reactance Interface This optional interface contains the circuitry necessary to convert the voltage and current, measured during a Leakage Reactance test on a transformer, into a form that can be measured by the M4100 Instrument. It also contains a variac so that the proper test voltage can be obtained. The Leakage Reactance test cannot be made without either this Interface or the M4130 Leakage Reactance Module, and the accompanying software.
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When using this interface, the standard M4000 safety switch and safety strobe are used. The necessary current and voltage cables are provided for connection to the transformer, along with the necessary software, so that this becomes a self-contained kit for this test. The user is only limited by the size of the variac provided.



Figure 1.8 M4110 Leakage Reactance Interface



Operating with the M4300 Transport The M4000 Insulation Analyzer is designed to be assembled on the M4300 Transport for storage, moving, and testing. When the M4000 is used with the M4300 Transport, it can be set up in the following modes: • •



Storage and Moving Mode Testing Mode



Storage and Moving Mode The storage and moving mode will allow the user to transport and store the M4000 Insulation Analyzer. The M4300 Transport is designed so that all the components of the M4000 fit in a single, packaged unit (Figure 1.9).
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Controller Support Frame



High Voltage Cable



Cable Carry Bag



M4100 Instrument Oil Test Cell
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M4200c Controller



Figure 1.9 M4000 Insulation Analyzer in Storage Mode The recommended assembly steps for the Storage and Moving Mode is as follows: 1. Remove the M4200c Controller Support frame from the M4300 Transport. Lay the M4300 Transport down on its back, on a level surface so that the wheels and handle touch the surface. 2. Verify that the cover is installed on the M4100 Instrument front panel. Position the M4100 Instrument on the M4300 Transport as shown in the above picture.
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3. Position the closed M4200c Controller upside down into the area with the projections of the top cover of the M4100 Instrument. Buckle and tighten the strap snugly around both the M4100 Instrument and the M4200c Controller. 4. Lift the M4300 Transport into the upright position. 5. Place the Documentation Bag and Cable Carry Bag on top of the M4100 Instrument top cover. Buckle and tighten the strap to secure. 6. Place the Oil Test Cell on the brackets provided between the wheels on the rear of the M4300 Transport, and secure it with the strap provided. 7. Place the High Voltage Cable into the brackets provided on the top, rear part of the M4300 Transport and secure it with the strap provided. 8. Place the M4200c Controller Support frame into the tubes provided so that the end faces forward.
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NOTE



The M4200c Controller Support frame should not be used for lifting the M4300 Transport. The M4000 Insulation Analyzer is now in Storage and Moving Mode.
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Testing Mode When assembled in the Testing Mode, the M4300 Transport serves as the field desk for the M4000 Insulation Analyzer. The Testing Mode (Figure 1.10) was designed to take advantage of the M4100 instrument's concentrated cluster of connections, providing the user with a comprehensible testing setup and a user-friendly environment while testing.



Intercase Communication Cable



M4200c Controller



M4151 Calibration Reference



Safety Switch 1&2



High Voltage Cable 120/240 V Power Cable Remote Temperature Humidity Sensor



Safety Ground



Safety Strobe



Transporter



Diagnostic Test Adapter Cable Loopback Test Connectors



Blue Low Voltage Cable



Red Low Voltage Cable



Figure 1.10 M4000 in Testing Mode
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Controller Support Frame



Testing Mode



The following instructions describe how to assemble the components of the M4000 Insulation Analyzer into the Testing Mode, from the Storage and Moving Mode:



WARNING



When preparing for a test, do not attach any test leads to the apparatus to be tested without first attaching them to the M4100 test set! 1. With the M4300 Transport in the upright position, remove the M4200c Controller Support frame, the Cable Carry bag, the Documentation bag, the High Voltage Cable, and the Oil Test Cell from the rear of the Transport. 2. Carefully lay the M4300 Transport down on its back on a level surface. The handle should face the specimen to be tested. 3. Place the M4200c Controller Support frame into the tubes provided on the M4300 Transport bottom plate, near the M4100 Instrument rubber feet. The top of the frame must extend away or opposite to the handle.
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4. Remove the M4200c Controller from the top surface of the M4100 Instrument. Place the M4200c Controller on the Support frame and lock it in place. 5. Remove the top cover from the M4100 Instrument top panel. The M4100 Instrument is ready for connecting the cables. 6. The M4100 Instrument top panel receptacles are designed to only accept the functionally correct cables. Place each cable into the respective receptacle. The only interchangeable cables are the Safety Switches. NOTE



Inspect all cables for cracks or other damage before using. 7. Connect the Safety Ground cable to the M4100 Instrument, and to the ground of the specimen to be tested. The Safety Ground Cable should be the first connection to be made and the last one disconnected from the M4100 Instrument. 8. Connect the M4100 Instrument and the M4200c Controller to the Power Receptacle Box located at the bottom of the handle of the M4300 Transport. A separate receptacle box is also provided for cases where the M4000 Insulation Analyzer is used away from the M4300 Transport. As shipped from Doble, the 120 VAC receptacle in the M4200c Controller is located under a yellow tag which states, “NOTICE: READ ENCLOSED MICROSOFT SOFTWARE LICENSE BEFORE USING”. The license agreement and documentation are in the Documentation bag. Please comply with the notice and remove the tag to plug in the cable. 9. Interconnect the M4100 Instrument and the M4200c Controller using the gray snap-in cable provided.
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10. Connect the two safety switches to the two receptacles labeled “Safety Switches” on the front panel of the M4100 Instrument. 11. Connect, as necessary, the red and blue Low-Voltage leads to the corresponding color coded receptacles labeled “LOW VOLTAGE LEADS”, on the front panel of the M4100 Instrument. To avoid unintended measurements, connect only the low voltage lead(s) to be used for the next text. 12. Connect the Safety Strobe to the receptacle labeled “SAFETY STROBE” on the front panel of the M4100 Instrument. The strobe has a magnetic base that can be placed on a grounded steel structure, where it is visible to all personnel around the testing area.



14. Connect the High-Voltage Cable to the receptacle labeled “HIGH VOLTAGE” on the front panel of the M4100 Instrument. Ensure that the High Voltage Cable is fully inserted and latched into the receptacle. 15. Connect the M4000 Power Receptacle box to a 120 or 240 VAC source. This should be the last connection to be made. 16. The M4000 Insulation Analyzer is ready to be connected to the specimen to be tested. Connections to the specimen are described in the Doble Test Procedures manual. NOTE



When the M4000 Insulation Analyzer is assembled in the Test Mode it should not be moved. However if minor repositioning is necessary it should be done by lifting the M4300 handle a few inched off the surface.



When Finished Testing When tests are finished, and before starting the Storage and Moving Mode assembly procedure, make sure that all the data have been saved and that the application programs that were used have been closed before shutting power off to the M4200c Controller.



WARNING



When finished testing, do not remove any of the test leads from the test set before first removing them from the apparatus just tested!



72A-1230 Rev. F



1-15



July 22, 2005



13. Connect the Temperature and Relative Humidity Sensor to the receptacle labeled “REMOTE SENSOR” on the front panel of the M4100 Instrument. This sensor will automatically record the ambient temperature and humidity. The sensor has a magnetic base and should be placed on a grounded structure, in the shade, to record the most accurate temperature and humidity. The M4100 Instrument will operate without this option.



M4000 PC Cable



NOTE



Data will be lost if all software application programs are not closed before the M4200c is powered down. To set the M4000 to the Storage and Moving Mode, reverse the previous setup procedure (”Testing Mode” on page 1-13), keeping in mind that the Safety Ground cable is the last cable to be disconnected from the M4100 instrument. Refer also to ”Storage and Moving Mode” on page 1-10.



M4000 PC Cable There is a cable with connectors designed to attach your M4100 to a thirdparty controller of your choice. This cable is supplied as a way to offer users an even higher level of product reliability. With the M4000 PC Cable, the user can continue to test even if the M4200c Controller suffers a serious failure, by using the cable to connect the M4100 Instrument directly to the user’s own PC.
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To be prepared to use this cable, you must have the DTA and M4000 diskettes available to load onto your computer, and preferably a back-up copy of test data files as well.



Third-Party Controller Requirements



• • • • •



Pentium Celeron 64 megabytes of memory Windows 98 or later operating system Internet Explorer version 5.0 or better One available serial port



See the Doble website (www.Doble.Com) for complete details.



Setting Up the Controller



The computer must be loaded with the M4000 (and DTA, if a DTA user) software. The COM port setting must be set in accordance with your computer's requirements. This can be done by selecting Configuration from the Tools menu and clicking the Instrument tab. The COM port is automatically set to the requirements of the M4200c Controller when you install the M4000 software. If you are using a Serial to USB converter, see ”Instrument Configuration” on page 2-18. If you have the wrong COM port setting, you will get a communications error message when trying to run a test. Besides the COM port setting, you must be sure no other program is running that wants to access this same COM port. Review programs located in your startup folder which start up each time the computer is booted up, and remove any that may try to grab the COM port. Or, from the System icon in the Control Panel, go to the Hardware tab and select Device Manager. Disable any items that require the selected COM port.
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Transport, Storage and Shipping Transporting and Storing the M4000



The M4100 and M4200c should be properly secured within the vehicle when being transported locally, and mounted in the normal upright position (preferably a location, in a van or truck, which is not directly above an axle of the vehicle). If a padded shipping container or trunk is not used when transporting the Instrument and Transformer locally, then protect against road vibration and bumps by having them mounted on shock absorbing material (2" to 4" of padding is desirable). Avoid sharp bends in the High Voltage Test Cable when both using and transporting. The cable should be coiled into no smaller than a 12-inch diameter coil.



72A-1230 Rev. F



1-17



July 22, 2005



The M4100 Instrument, M4200c Controller, and Accessories should be stored in a reasonably clean and dry location. If the M4100 Instrument, M4200c Controller, and/or the inboard or outboard potheads of the High Voltage Test Cable are exposed to excessive dirt and/or moisture, they should be cleaned and dried before use. The inboard and outboard potheads of the Cable, and the cable pothead guide receptacle on the M4100 Instrument, could track along their surfaces if high voltage is applied while they are contaminated with surface dirt and/or moisture.



Shipping Instructions



Shipping Instructions M4000 Test Set



Always ship the M4000 and M4200c in separate containers. Ship in special packing cases provided by Doble or pack in cases with at least 4" of Styrofoam-type padding on all sides. The HV cable pothead-guide receptacle on the M4100 Instrument should be covered to keep out foreign material. On package, write: FRAGILE – PLEASE DO NOT DROP



Accessory Case



Pack leads, cables, and accessories in the cable bag furnished with the set.
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Liquid-Insulation Cell The Cell and Plastic Carrying Case must be thoroughly cleaned to prevent accidental contamination of the Accessory Case and the environment. If the Accessory Case is either not shipped or is too full, then the clean Cell and Carrying Case should be shipped in a separate padded cardboard box, or better. Padding should be installed inside and around the Cell. On package, write: FRAGILE – PLEASE DO NOT DROP NOTE



When shipped by commercial carrier, the M4100, M4200c and Accessories should be properly padded and packed as specified above. Suitably padded shipping containers for temporary use or purchase are available from Doble upon request. Ship to: Doble Engineering Company 85 Walnut Street Watertown, Massachusetts 02472-4037 USA



NOTE
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Test sets that are transported appreciable distances should be checked upon arrival. This includes sets that have been shipped from the Doble Engineering Company. The test set and its accessories should be examined upon receipt for signs of physical damage. The simplest and most effective method for checking overall performance of the M4000 is to use the Doble Liquid Insulation Cell as described in ”Checking Instrument Accuracy in the Field” on page 4-43.
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The preceding also applies to test sets that have been stored for prolonged periods.



Safety Considerations Safety cannot be overemphasized when working on or around high voltage electrical apparatus. Companies that generate, transmit, distribute, or utilize high voltage electricity should, and do, have precise rules for safe practices and procedures for personnel whose working responsibilities involve testing and maintenance of the various types of high voltage apparatus, and their associated lines, cables, and conductors, as well as the associated accessories.



Definitions



• • •



Test Set Operator – The person who supervises the test and operates the M4000 Insulation Analyzer. Operator’s Assistant * – The person who follows the operator's instruction in making test connections. Safety Observer * – The person who is responsible for observing the performance of the test, seeing any safety hazard, and giving warning to crew members.



* The operator's assistant, or the safety observer, may be employed to operate the extension safety switch and to act as safety supervisor. The operator of the safety switch should perform no other work, such as recording test data, while the M4000 Insulation Analyzer is energized. Two safety switches are provided and are required to be operated in order to energize the M4000 Insulation Analyzer. The M4000 Insulation Analyzer generates high voltage and is capable of causing serious, even lethal, electrical shock. The M4000 Insulation Analyzer should not be operated by a crew smaller than two people. A larger crew may be desirable under some circumstances. Regardless of crew size, one person should be designated as the Test Set Operator and one other as Test Supervisor.
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Throughout this manual, reference will be made to testing personnel in certain general terms which are defined below. These terms apply only to the testing function of the individuals and not to their professional status, seniority, or positions within their company's structure or personnel hierarchy. These terms are:



Safety Practices – General Rules



•



Test Supervisor – This person is responsible for overseeing preparations for the test sequence, overseeing M4000 Insulation Analyzer operation, and ensuring that all safety precautions are put into practice. Safety practices followed should include company policies, applicable government regulations, and any special requirements related to use of the M4000 Insulation Analyzer.



Safety Practices – General Rules 1. All tests should be performed with the apparatus under test completely de-energized and isolated from its power systems. This means disconnecting and grounding all bus from the apparatus under test. 2. The method of testing high voltage apparatus involves energizing the apparatus through the M4000 Insulation Analyzer. The act of testing apparatus, which is otherwise de-energized and isolated from its system, can itself produce dangerous levels of voltage and current. Care must be taken to avoid contact with the apparatus being tested, its associated bushings and conductors, and with the M4000 Insulation Analyzer cables. July 22, 2005



3. The test crew must make a visual check to ensure that the apparatus terminals are isolated from the power system. Where the possibility of failure of the apparatus under test must be considered a real possibility, precautions (such as barriers or entrance restrictions to test area) must be taken against harm in the event of violent failure. 4. All rules of your company for safe practice in testing must be strictly conformed to, including all practices of tagging and isolating apparatus during testing and maintenance work. State, local, and federal regulations, e.g. OSHA, may also apply. NOTE



Company rules and government regulations take precedence over Doble recommendations.



Clearances Proper clearance between the test equipment, crew members, and the apparatus being tested, must be observed at all times during energization. Barriers, safety tapes, and ladder barriers should be erected around the test area to prevent unintentional (or intentional) entry into the “live” area. These same precautions should be taken to block unwitting entry into the area by means of ladders, buckets, or any other extraneous equipment by which entry into the area may be gained.
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Grounding 1. The apparatus under test, its tank or housing, and the M4000 Insulation Analyzer must be solidly and commonly grounded or earthed. This also applies to any mobile equipment being tested. 2. When the M4000 Insulation Analyzer is permanently housed in a vehicle, the M4000 Insulation Analyzer ground should be bounded to the vehicle chassis, which in turn is grounded. 3. Exposed terminals of apparatus should not normally be allowed to “float”. They should be grounded directly or through the low voltage leads of the M4000 Insulation Analyzer, unless otherwise specified by Doble recommended test plans. 4. There must be two inches of clearance between conductors (such as bus) that are not part of the tests.



1. A pretest tailgate meeting is recommended. Frequently, other crews will be working on non-test related tasks in close proximity to equipment being tested. The tailgate meeting should include all personnel who will be working in proximity to the area where testing will be performed. In this meeting, the tests to be performed, the apparatus and the voltage test levels involved, potential hazards involved with the work, and the individual assignments should all be reviewed with the crew members. Test personnel need to remain aware of the work activity taking place around them and alert to the possibility that non-test personnel may enter the test area. 2. A consistent and uniform set of signals, both visual and verbal, should be agreed upon, and should be followed by all of the crew members during testing. 3. While making the various types of connections involved in the different tests, it may be necessary for personnel to climb up on the apparatus, but no one should remain on the apparatus during the test itself. 4. The HV Test Cable should not be held during energization of the M4000 Insulation Analyzer. Flashover of the test specimen or the M4000 Insulation Analyzer can generate transient voltages of sufficient magnitude to puncture the insulating jacket of the cable.
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Personnel Safety



M4000 Connections



M4000 Connections 1. The procedures described in the “Testing Mode” section of this chapter on page 1-13, for connecting and disconnecting the M4000 leads in their proper sequence should be observed and acted upon at all times.



WARNING



In particular, due to the presence of static charges from nearby energized lines, never touch the live end (hook) of the high voltage cable when moving leads. Never hold the High Voltage cable during a test.
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2. Test personnel should be aware that induced voltages or trapped charges may be present on the equipment about to be tested. EHV circuit breakers with grading capacitors across the interrupter contacts are especially prone to build up a high voltage charge. Voltages high enough to damage the M4000 Insulation Analyzer have been known to occur on this type of equipment. Provisions should be made for draining these charges by applying grounds prior to making your test connections. It is a good practice to ground equipment such as capacitors, capacitor voltage transformers, and EHV circuit breaker heads as soon as they have been isolated for testing, and to temporarily remove the grounds only during the short period when tests are actually being performed. 3. Perform only one job at a time on any apparatus. The situation in which two crews are doing different tasks with the same apparatus at the same time is an open invitation for confusion, trouble and danger to the personnel.
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M4000 Operation 1. Both safety switches must be used in order to activate the test setup. One is to be controlled by the M4000 operator and the other by a second test crew member, designated the safety supervisor. (This person may be either the Operator’s Assistant or the Safety Observer.) 2. The Test Set Operator or the Safety Observer must be able to have an unobstructed view of the terminals of the equipment under test, any points of entry into the immediate test area, and of the workers in the area.



M4000 Safety Features



1. A #6 copper conductor is provided by Doble for the purpose of grounding the M4000 Insulation Analyzer. The heavy-duty #6 conductor should be connected to the GROUND RECEPTACLE of the M4000 Insulation Analyzer at one end and to the station grounding system at the other end. This should be the first step in setting up the M4000. 2. After the M4000 Insulation Analyzer is properly grounded, the remaining test leads and the HV Test Cable are plugged into their receptacles. Do not connect test leads to the apparatus terminals until after the leads are connected to the M4000. 3. The power cord should be plugged into a 120V ac or 240V and grounded receptacle. This should be the last step in setting up the M4000. 4. Two separate grounds are required to pick up the ground relay and operate the M4000: one as described in item 1 above, and the other through the third wire of the 120/240 volt supply cord. Care should be taken to ensure that there is no direct contact between the two grounds. Short circuiting the two grounds together may create a hazardous condition if the ground connection is inadvertently interrupted. 5. The HV Test Cable used with the M4000 is a double-shielded cable in which the high voltage is exposed only at the outboard pothead tip. The HV Test Cable should not be handled while it is energized. If a flashover occurs while testing, transient voltages higher than 10 kV can appear on the cable and puncture the insulating jacket of the cable, creating a hazard to personnel holding the cable. The cable may be suspended or tied off in such a way as to avoid handling.
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The M4000 Insulation Analyzer is equipped with a ground-relay scheme, which prevents test voltage from being applied until the following preliminary conditions have been established:



M4000 Safety Features



6. The M4000 includes a safety strobe with a magnetic base that can be placed on a grounded steel structure where it is visible to substation personnel. The safety strobe is enabled and required to be connected when running a test by default. Although this can be defeated in the process of instrument configuration, this should be done only if the strobe is not working and cannot be used. 7. During operation, an audible beep is heard whenever high voltage is being applied. This beeper is enabled by default. Doble recommends the default, although the beeper can be turned off as part of instrument configuration. The M4000 Insulation Analyzer is heavy. The M4100 Instrument alone weighs approximately 100 pounds (45 kg). Doble recommends that at least two persons be used to move the M4100 in the field. Special care must be taken in lifting the M4100 into or from a vehicle to avoid bodily injury.
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WARNING
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Safety Precautions Doble insulation analyzers require operation by at least two persons. The M4000 Insulation Analyzer operator has his/her own Operator's Safety Switch. A second switch, called the Extension Safety Switch, is provided. The cable for the Extension Safety Switch is equal in length to the High Voltage Test Cable. Both switches are of the spring-release type for quick action. With either switch off, all voltage to the High Voltage Test Cable is removed. The person responsible for attaching the High Voltage Test Cable to the specimen should operate the Extension Safety Switch, and should be positioned so as to be able to observe all terminals and points of access to the apparatus under test. If this is not possible, then the out-of-sight terminals should be roped off with CAUTION labels appropriately placed, and a person posted in the vicinity to ensure safety.



It is recommended that the Extension Safety Switch be the last switch closed. The Extension Safety Switch must remain open until all personnel are safely in the clear. Personnel should not be allowed to remain on the apparatus while tests are in progress. If unauthorized personnel should enter the area, or if some other undesirable situation should develop, the Extension Safety Switch operator should release the switch immediately, and then notify the M4000 Insulation Analyzer operator. The two safety switches are intended to be used as a “dead man” type switch. Both safety switches should be used at all times. Never short circuit them and do not use fixed mechanical locking devices for depressing the switch button. The switch button must be manually operable at all times. The M4000 operator and the operator's assistant should follow a uniform system of visual and verbal signals in order to prevent confusion during the testing process. For example, when the test connections have been completed and all personnel are in the clear, the operator's assistant should make visual contact with the M4000 operator and call “ready”. The M4000 operator, before bringing up the test voltage, should acknowledge the assistant's signal, and advise all present by calling out “coming hot”. Upon completion of the test, the operator should call out, “all clear”. To demonstrate further that the test has been completed, it is good practice for the M4000 operator to extend the Operator's Switch at arm's length with the button released, for all to see.



72A-1230 Rev. F



1-25



July 22, 2005



Each time the test equipment is set up, and prior to making the first test, both safety switch operators should cooperatively verify the correct operations of both switches.



Safety Precautions for Various Types of Apparatus



After the tests are completed, all test leads should be disconnected first from the equipment terminals and brought down to ground level before they are disconnected from the M4100 Instrument. The #6 copper test set ground should be the last lead to be disconnected from the set.



WARNING



Never attempt to disconnect the HV Test Cable or the Low Voltage cables from either the terminals of the test specimen to which they are connected at the outboard end, or from the receptacles on the M4100 instrument at the inboard end, unless the M4000 VOLTAGE CONTROL is set to ZERO, and the Operator's Safety Switch and the Extension Safety Switch are both released. Attempts to disconnect leads while the M4000 is energized may result in a serious, and possibly lethal, electrical shock.



Safety Precautions for Various Types of Apparatus
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In addition to the items included in ”Safety Practices – General Rules” on page 1-20, the following are specific considerations that have to do with the testing of various types of apparatus:



Bushings



When performing either single or multi-hot-collar tests using rubber Hot Collars, be aware that the rubber collar is a conductor, and that it is at the test voltage during the test.



Breakers



Prior to any testing, steps should be taken to disable the breaker so as to avoid inadvertent operation during testing. In a closed breaker test, both bushings will be energized at test potential, and contact between the bushings and either test personnel or test leads should be avoided. When testing lift-rods, operating rods, or any component internal to the breaker, the operating mechanism should be blocked, fuses removed, and any other necessary measures taken to ensure that the breaker is inoperative.



Transformers



1. When performing bushings tests, the opposite windings should be grounded. 2. When performing excitation tests, floating terminals should be considered live. 3. Use caution when applying test voltages to a transformer from which the oil has been removed. Recommended test voltages for testing a transformer without insulating fluid are listed in the Doble Test Procedures manual. 4. Under no circumstances should test voltages be applied to oil impregnated insulation while the insulation is under vacuum.
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Instrument Transformers



In addition to isolating and grounding live terminal(s) of the primary winding, secondary fuses and other leads should be removed in order to completely and effectively isolate the unit from the system. This is especially important in the case of potential transformers.



Voltage Regulators



Check to ensure that there are no closed secondary links in order to eliminate the possibility of backfeed.



Surge Arresters



Everyone is instructed to stand clear during the testing of surge arresters because of the possibility of their violent failure.



Capacitors



1. Close all the grounding switches on the device housing in order to ground the bottom terminals of the capacitor.
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2. Make sure capacitor stacks are discharged before you come into contact with them. Internal resistors should not be relied upon for discharging individual capacitor cells. Capacitors intended for usage may not contain internal resistors. Resistors in failed capacitor cells should be considered suspect. For additional protection, it is recommended that the terminals of individual cells be discharged before personnel come in contact with them.
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Safety Summary In summary, it is worth noting that many of the accidents that happen around high voltage apparatus and its associated conductors involve personnel who are familiar (perhaps too familiar) with high voltage equipment. Staying alert and ever watchful requires constant training and awareness of the inherent hazards. The greatest hazard is the possibility of getting on a “live” circuit. To avoid this requires constant vigilance – for oneself and for one's fellow workers. In addition to the obvious dangers, personnel should be alert to recognize subtle dangers as well. For example, during transformer excitation-current tests, the “floating” terminals may have significant voltages induced in them by simple transformer action. Thus, all terminals of an apparatus under test, unless grounded, should be considered to be “live” while the test is in progress.
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In the case of potential transformers or any transformers which may be interconnected, voltage can be back-fed through the secondaries to produce high voltage on the primary, although the primary is seemingly isolated from the power system. This re-emphasizes another rule: All terminals of an apparatus to be tested should be completely isolated.



Remember: SAFETY .........................FIRST, LAST, ALWAYS!
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2. M4000 Software Upgrading or Installing M4000 Software Your M4200c Controller comes with all necessary software pre-installed. This consists of the Windows XP operating system, the M4000 program, and for users of the Doble Test Assistant, the optional DTA program. You may also request the optional Leakage Reactance Test or External Reference Test software. You may need to install this software if you are loading it onto an office computer or laptop, upgrading from a previous version, or reinstalling it. This chapter covers the following subjects: • •



Installing M4000 software on your PC. Introduction to M4000 Software/Icon Descriptions/Configuration Settings (see page 2-6)



WARNING



NOTE
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Software Installation Before starting, BACK-UP YOUR TEST DATA



If you have customized limit files, location.txt, and division.txt files from DTA, save them separately, so you can transfer the data to the new version.



M4000 Software NOTE



The first time a test is run with newly installed software, the M4200c Controller or your laptop computer being used as a Controller must update the M4100 Instrument firmware. The user is notified of this process by the message, “Downloading firmware to the M4100 Instrument – Please wait”. Do not interrupt this process. Otherwise, the previous version of the software must be reloaded onto the M4200c or your laptop, then the new version installed once again. This section contains the steps to follow to install the M4000 software.
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M4000 Software



If you have already installed the current version of the M4000 software, and you only wish to add either or both of the optional features, Leakage Reactance and External Reference/Source testing, each of these disks contains its own setup function and can be installed separately as described below. To install the M4000 software and/or either of the optional features, follow this procedure: 1. Make sure all your existing test data is backed up! 2. In Windows, select the “Run” option from the Start button menu. The Run dialog box appears. 3. Insert the installation diskette in the A: drive (or CD into its drive). 4. Type the following in the Run dialog box: A:\setup (or corresponding drive letter for the CD drive), and press the ENTER key.
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5. Select the language for the installation instructions. After installation, any of the listed languages can be chosen at any time from the Advanced tab of the Tools/Configuration window, as long as they have been installed in step 8 below.



Figure 2.1 Language Options 6. The program will ask in which directory to install the M4000 Software. It is recommended to stay with the default settings. Note that it is different from the existing version, so that you may use either version on the same computer. Press the ENTER key. NOTE



Optional Leakage Reactance software must be installed in the same directory; the optional DTA software may go in its own directory. 7. You will be asked to select some installation options:
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•



Launch M4000 at Startup: Select this option if this computer is dedicated to M4000 tests, since it automatically runs the M4000 program when starting the computer (If you have the icon for the old version of the software in your startup folder, remove it). Set the serial communications port to COM2: select this only if installing the software on an M4200c controller.
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•



Figure 2.2 M4000 Software Installation Options 8. You will then be asked to select safety options:



Figure 2.3 Safety Settings •
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Beeper Is Enabled: Enables the audible warning feature that signals the beginning of each test (recommended).
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M4000 Software



•



•



•



•



NOTE



Both LV leads must be inserted to run test: requires that both the red and blue leads be inserted into the test set to run a test (rarely used). Safety strobe is required to run test: In the event there is a failure of the strobe bulb or cable, this should be disabled so as to be able to continue testing without it. Safety switch must be released between tests: Serves to discourage user from artificially holding safety switch down for the duration of several tests. Restrict the Safety Configuration settings: If selected, serves to lock the above 4 selections so that they cannot be changed from within the application.



Use this last option with care, since if a need arises to change one of the above settings (a burnt out strobe light bulb), you cannot change the settings and continue testing without reinstalling the software.
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9. A screen will appear where your company name, as you wish it to appear in the Nameplate area, can be input. Leave it blank if you prefer to fill the name in manually each time. 10. Finally, you will be asked which languages you wish to have installed on the computer. You may choose English, French, Spanish, and Portuguese, and different users may switch among them from the Tools/Configure/Advanced menu.



Figure 2.4 Languages Installed 11. If using diskettes, insert subsequent disks when prompted and press the ENTER key. 12. You will be asked if you wish to read the “readme” file.
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13. Since you are able to have both the old and new versions on the same computer, you may wish to be able to switch back and forth at first. To avoid downloading firmware to the M4100 each time you switch, do the following: •



•



Find the M4i.x0, Bootblok.x0, and Loader.x0 files in the directory where the new version 3.0 is installed (the default is C:\Program Files\Doble\M4000). Copy these 3 files into the directory of the older version you are using.



Installation of the M4000 Software is now complete.



Doble Test Assistant (DTA) Software (Optional) See instructions found with the DTA software.



Optimization If the software has been installed on a PC, you may have to adjust the COM port setting if the wrong choices were made during installation. If you are not able to run any tests on the M4000, but get a communications error, proceed as follows: 1. Select Tools/Configuration, and choose the Instrument tab. 2. Set the Serial Port to COM 1. 3. Make sure the baud rate is set to 9600. 4. Click OK, reboot the computer, and try again. 5. If there is still trouble communicating, your laptop may require another choice. Possible COM port choices are 1, 2, 3, or 4. Besides the COM port setting, you must be sure no other program is running that wants to access this same COM port. Review programs located in your startup folder which start up each time the computer is booted up, and remove any that may try to grab the COM port. Or, from the System icon in the Control Panel, go to the Hardware tab and select Device Manager. Disable any items that require the selected COM port.



Mouse Settings You can modify the mouse settings for maximum visibility on the M4200c Controller:
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COM port Setting



Time/Date Format



• • •



From the Windows “Start” button, choose “Control Panel” from the “Settings” menu item. Double-click on the Mouse Icon, then select the “Motion” tab. Click the “Show Pointer Trails box, adjust the scale marker to “Long” and click OK. This will cause the mouse to leave a trail behind it when moved, and increase visibility in bright sunlight.



Time/Date Format You may want to change the time/date format. The default is mm/dd/yyyy for date, and 12 hour format for time. To change this format, Select “Control Panel” from the Windows Start button menu. Time and date format can be changed from the “Date and Time” icon, and this change reflects through to the M4000.



Introduction to M4000 Software
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What’s New Aside from some behind the scenes changes to make this program a modern up to date 32 bit program, here are some features visible to the user:



Clipboard



1. The clipboard now has 200 lines instead of 36, so that almost any type of testing should be able to fit in one single file. 2. The M4000 program now supports English, French, Portuguese, and Spanish. 3. Serial Number and Manufacturer fields have been added to the nameplate area. 4. The column widths on the test grid are user-configurable. 5. For each test, time, date, air temperature, and humidity are recorded and can be viewed. 6. A new file structure has been implemented, allowing user-specified file names for easier data manipulation. 7. The printout now has a grid around the data, for a more professional look. 8. The Clipboard mode now has graphing capabilities (see ”Graphing Test Results” on page 3-11). 9. The Clipboard mode now offers automatic temperature correction (see ”Temperature Correction” on page 2-12).
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Leakage Reactance



10. One Leakage Reactance file can now contain all tests in a series: Three Phase Equivalent, Per Phase, and tests on different taps. Data entry is now more intuitive.



External Reference



11. On the External Reference form, both UST and GST tests can be stored all on the same form. 12. You may now store reversal readings on the same line and automatically average the results. 13. You may now store test circuit loss associated with the GST test, and the program will automatically subtract the loss from the test results.



The M4000 Program To start the M4000 Software: turn on the M4200c Controller; or, if using your laptop, and the program executable is not in your “StartUp” group: 1. Select All Programs from the Windows Start button menu. 2. Select the Doble Program Group. 4. Click the OK button on the “About The M4000 Software” window. You are now at the M4000 clipboard screen. The menu bar contains a number of choices, with a row of short-cut icons just below.



Icons Before step 4 above, the basic icons shown and their functions are described as follows: Icon



Description



Open M4000 data file. New M4000 files have the extension .m4k, but old M4000 files can also be opened using this command. Exit the M4000 Software, or select Exit from the File pull down menu.
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3. Select the M4000 icon.



Menu Bar



Icon



Description



Enter DTA Field System Software, or select DTA from the Mode pull-down menu. With DTA, the second test mode available is DTA. See the DTA instruction manual for use of the DTA option. DTA contains specific forms for different apparatus types, along with an expert system to evaluate results. Since this is optional software, this icon will not be active if DTA software is not installed. Enter Clipboard Mode or select Clipboard from the Mode pull-down menu. Without DTA, the only test mode is Clipboard. The clipboard mode is described further in this chapter. It provides a generic form for testing any apparatus. Enter External Reference/Source Mode, or select External Reference/ Source from the Mode pull-down menu. Since this is optional software, this icon will not be active if External Reference software is not installed.
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Enter Leakage Reactance Test Mode, or select Leakage Reactance Test from the Mode pull-down menu. Since this is optional software, this icon will not be active if Leakage Reactance software is not installed. Find help, or press the F1 key, or select the items from the Help pull-down menu item. Help is described in the 'Using Help' section of Chapter 1.



Menu Bar The Menu Bar functions are described as follows: Mode: Allows selection of available test modes. Clipboard is automatically included with the M4000 software. External Reference/Source, Leakage Reactance, and DTA are optional software add-ins. Diagnostics: These help you check the status of the M4000 Insulation Analyzer, and to diagnose any problems that may exist. See ”Running Diagnostics” on page 4-21 for a description of this item View: De-selecting an item from this menu will remove the icon bar from your screen. Select again to restore it. Tools: Here you can clear test and nameplate data, view a test note or temperature/humidity data, or adjust configurations. See the “Configuration” section in this chapter for a full description of these options.
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Clipboard Test Mode To enter Clipboard test mode, click the the Mode pull-down menu item.



icon, or select Clipboard from
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The following screen will appear:



Figure 2.5 Clipboard Screen Clicking on the following icons will perform the described functions: Icon



Description



Open a File. If a Clipboard file is saved, it can be retrieved by clicking on this icon, pressing F9, or selecting Open from the File pull-down menu. Save a File. This can also be done by pressing CTRL+S to save the file with the existing name, or the F8 key to save with a new name. Print the current Clipboard form. This can also be done by selecting Print from the File pull-down menu item, or by pressing F7.
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Menu Bar



Icon



Description



Enter the DTA Field System program. This can also be done by selecting DTA from the Mode pull-down menu item.



Click to open a Clipboard screen, where tests may be run and recorded. Click to enter External Reference/Source Mode, or select External Reference/ Source from the Mode pull-down menu.



Click to enter Leakage Reactance Test Mode, or select Leakage Reactance Test from the Mode pull-down menu.
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Run a single test. This can also be done by selecting Run A Single Test from the Test pull-down menu item, or by pressing F2. Run a multiple test. This can also be done by selecting Run A Multiple Test from the Test pull-down menu item, or pressing FN+F11. Enter a note. When clicking on this icon, the software will ask you which line the note corresponds to. The default is for line. This can also be done by selecting Edit Test Note from the Edit pull-down menu item. View the air temperature and percent humidity associated with each line of test data. This can also be done by selecting Display Temp./Humidity from the Edit pull-down menu item. Allows user to activate automatic temperature correction function for the clipboard test mode. Graph the selected clipboard results
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Icon



Description



Toggle sheet note. Click this icon to display or hide a note area for the entire clipboard sheet at the bottom of the screen.



Toggle Nameplate. Click this icon to display or hide all but the test data. This allows the user to hide or display the Nameplate information, time, date, Administration and Test Condition buttons. About M4000 For Windows. This can also be chosen by selecting About M4000 For Windows from the pull down menu item. If you are using the pull-down menus and wish to remove these icons, click on the View pull-down menu item and then click on Toolbar. This will disable the icons. They can be retrieved by repeating the same action.



Menu Items The menu items are File, Mode, Test, Diagnostics, View, Tools, Window, and Help. The principal functions included under these items are better accessed by using the icons described in the previous paragraphs. The features under what used to be the Edit menu are now found under Test by selecting the Clear menu item. The Diagnostics commands are described in Chapter Six, M4100 Instrument.



Mode Menu Select the type of test desired. Choices are: • • • •



Clipboard (for Power Factor, Exciting Current tests) Leakage Reactance (Requires optional software) External Reference/Source (Requires optional software) DTA (Requires optional software)



Test Menu This menu contains the start single test (F2) and start multiple tests (F11) commands.
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NOTE



Diagnostics



Diagnostics This menu contains several self-test options, described in ”Running Diagnostics” on page 4-21.



View Menu Commands here allow display or hiding of the: • • • •



Toolbar (row of icons) Status Bar (along the bottom of the screen, it includes status of the Caps Lock and Num Lock functions, which should be off) Nameplate data fields Sheet note located just above the Status bar at the bottom of the screen.



Tools Menu This menu includes the following: • July 22, 2005



• • • • •



• •



Insert a test line command, inserts a new row above the row in which the cursor sits. Remove an empty test line removes the empty line on which the cursor sits. If the line is not empty, a warning message appears. Clear command for test results, nameplate data, test note, and sheet note Test Note command, which allows access to individual test notes for each line of test data Temp and Humidity command, which allows access to the temperature and humidity readings for each line of test data. Temperature Correction, as described below, enables the user to select the type of apparatus under test so as to activate automatic temperature correction. Graph results command, allowing the user to select test results on the clipboard and graph them. Configuration settings for both the software and the instrument, described under ”Configuration” on page 2-13.



Temperature Correction To activate automatic temperature correction: 1. First, run your tests and fill in the rows with the results.
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2. Click the temperature correction icon Correction from the Tools menu.



, or select Temperature



3. In the Temperature Correction window, fill in the rows on the clipboard screen to which you wish to apply the temperature correction. These rows must have temperature data associated with them for this function to work. 4. Select the Equipment Type and Sub-types where applicable. 5. Click OK, and Clipboard will apply the appropriate correction factor to the selected rows of test data.



Configuration There are five option tabs available in the M4000 Configuration window, accessed from the View menu item. They are System, Clipboard, DTA, Instrument, and Advanced.
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System Configuration When selecting the System tab, the following appears:



Figure 2.6 M4000 System Configuration
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Clipboard Configuration



Ramp Mode - Auto Ramp Mode raises the voltage automatically at a rate selected separately in the Clipboard Configuration and DTA Configuration. Manual Set Voltage allows raising the voltage by pressing the PGUP key to raise the voltage rapidly, the PGDN key to lower the voltage rapidly, the up arrow key to raise the voltage slowly, and the down arrow key to lower the voltage slowly. The rates at which the voltages are raised and lowered manually are selected separately in the Clipboard configuration and the DTA Configuration. Line Frequency - Select the frequency that corresponds to the user's system; or, if trying to duplicate a test result made at another frequency, select either frequency. Under normal system conditions, make the ± 5% selection. If your power line frequency is itself experiencing this degree of variation, you may be required to make the ± 10% selection to avoid the effect of electrostatic interference. The M4000 users Line Frequency Modulation to measure above and below power line frequency to avoid measurement of electrostatic interference.
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M4000 Data Directory - This is the directory in which the Clipboard data is to be stored. To change the default settings, use the mouse to click into the M4000 Data Directory field. Then, edit the settings to reflect in which directory the Clipboard data is stored. Select a directory other than C:\DOBLE\DTA for data storage for both Clipboard data and DTA data.* Click on the OK button to accept your changes. * For example, use C:\Doble\DTA\DATA. Company: If filled in, this line will cause all tests to use the information in the “Company” field when starting a new clipboard test.



Clipboard Configuration When selecting the Clipboard tab, the following appears:
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Figure 2.7 Clipboard Configuration Test Type - If Line Frequency Modulation is selected, a test at ± 5% of the reference frequency, will be performed. This selection is desirable when testing in the presence of electrostatic interference. If Line Sync Reversal is selected, a test at the positive polarity and a test at the negative polarity in reference to the input voltage at the base frequency is performed. This selection is desirable when performing tests using a resonator or exciting current tests on a transformer. Display Mode - If Reference to 10 kV is selected, all results will be reported as if 10 kV were the applied voltage. If results obtained were tested at 2 kV, current and watts measurements will be multiplied by 5. Historically, this is the way all Doble tests have been performed. If Actual Values are selected, all results will be reported in reference to the applied voltage.
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DTA Field Configuration



Loss Factor - There are two options available, Power Factor and Dissipation Factor, practically identical in routine usage. Dissipation Factor may be chosen when the user wishes to duplicate nameplate data from international manufacturers. However, the two are virtually identical at Power Factor readings below 5%. Units may be selected as Percent or Actual (and, for Dissipation Factor, mW/VAr). Power Factor is generally expressed in percent, and Dissipation Factor as Actual. Voltage Ramp Settings - The rate of voltage change corresponding to the Auto Ramp Mode and Manual Set Options is entered in these fields. For example, the default settings call for an increase of 100 volts every time the up arrow is pressed when manually bringing up the voltage. •
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•



•



Manual Mode Slow Step - The increment of voltage corresponding to each press of the up and down arrow key for manually setting the voltage. To change the default settings, click the mouse in this field and enter the desired voltage. Manual Mode Fast Step - The increment of voltage corresponding to each press of the PGUP and PgDn key for manually setting the voltage. To change the default settings, click the mouse in this field and enter the desired voltage. Auto Mode Ramp Step - The increment of voltage corresponding to the automatic voltage ramping steps. Using the default setting means that the voltage is raised and lowered in 500 volt increments. In the Auto Ramp Mode, voltage is lowered when a reversal is performed.



Click on the OK button to accept the selections.



DTA Field Configuration This only applies to users of DTA Field System Software. When the DTA Field Configuration tab is selected, the following appears:
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Test Type - See Clipboard Configuration for a description of this item. Voltage Ramp Settings - See Clipboard Configuration for a description of this item.
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Figure 2.8 DTA Configuration



Instrument Configuration



Instrument Configuration
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When the Instrument Configuration tab is selected, the following appears:



Figure 2.9 Instrument Configuration Serial Port - It may be necessary to change this setting to accommodate laptops being used with the M4100. The M4200c uses COM2, and laptops usually use COM1. The “bits per second” setting should not be changed from the default 9600. USB Converter- If using a Serial to USB converter to utilize a USB port on your laptop for connection to the M4100, check your PC settings to obtain the comport that has been set by the converter. For Windows XP, go to the Start button, select Control Panel/System (or alternately, right-click My Computer and select Properties), then click Hardware and then Device Manager. Click the plus sign next to Ports (Com & LPT) to see the comport assigned to your converter.
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Settling Time Delay- The time, at maximum test voltage, during which the M4000 samples the data. If it appears that excessive electrostatic interference is affecting test results, the settling time may be increased in order to sample the data over a longer period of time. To change the value in this field, click the mouse in this field and enter in a new value.



•



•



•



•



Beeper - If the beeper is enabled, four beeps will sound when voltage is applied to a specimen. If the beeper is disabled, there will be no audible warning of applied voltage. Both Low Voltage Leads must be inserted to run test - it is recommended this box be left unchecked, since most tests require only one lead. Safety Strobe required to run test- If “required to run a test” is selected, the strobe must be plugged in or a test cannot run. If the strobe is not available, select “not required”. Safety switch must be released between tests - Prevents users from defeating the purpose of the safety switch by artificially holding it shut. The switches should be pressed when the message onscreen tells you to.



Click on the OK button to accept your selection.



Advanced Configuration When the Advanced tab is selected, the following is displayed:
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Safety Settings - These may be set as desired, provided the option “Restrict the Safety Configuration settings” was not set during software installation. If it was, and you want to change these settings, you will have to re-install the software and de-select that option. It is recommended that unless they are not functioning, the user should leave the beeper and strobe light operational. The settings are:



Advanced Configuration
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Figure 2.10 Advanced Configuration Language: Choose from English, French, Spanish, and Portuguese, if selected for installation. Filter Type: The default is Slow, and should not be changed without consulting Doble. Capacitor Model: The default is Parallel, and should not be changed without consulting Doble. Inductor Model: The default is Parallel, and should not be changed without consulting Doble. Allow Multiple Documents: If this box is checked, more than one set of test data can be active and displayed at once. Current Range: The default is Auto, and should not be changed without consulting Doble. Watts Range: The default is Auto, and should not be changed without consulting Doble. Grid Font Size: Allows you to increase the size of the fonts on your screen, making it easier to see the data. Print Font Size: Increases the size of the font used in printing.
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Using Help When Help is selected, two options are presented: 1. Contents F1. 2. About M4000 For Windows...



Contents
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The Help/Contents option opens the Help window:



Figure 2.11 Help Window



When Contents is selected, you can find how to use Help by pressing F1. The contents screen also has a series of buttons along its top: The Glossary button has topics that are specific (such as, Auto Mode Ramp Step). If you are unsure which item to select, you can use the Search function located on the top of the Help screen to find a specific topic. To return to the previous screen, press Back located on the top of the Help screen. To view each item in the list of contents, press the >> button. To go back to the Help of the previous item, press 

 View more...
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